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IMPORTANT NOTICE 
 

The EKG/EMG Sensor described in this manual is for educational and research use only.  
It is not to be used as a clinical or diagnostic tool. 
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Overview of EKG/EMG  
 

 
EKG (Electrocardiogram) 
 
The  Qubit  EKG/EMG  (Electrocardiogram/Electromyogram)  Sensor  measures  voltage 
waveforms produced during the contraction of the heart (EKG) as well as during muscle 
contraction (EMG). The voltage changes are generated as follows.  

 

 
 

Heart muscle cells are polarized at  rest,  since  the cells have unequal concentrations of 
ions across their cell membranes.  An excess of positive sodium ions on the outside of the 
membrane causes the outside to be about 90 millivolts positive relative to the inside. This 
difference  is  the  "resting  potential".  Cell  membranes  are  impermeable  to  sodium, 
however,  stimulation  of  a muscle  cell  causes  a  temporary  increase  in  permeability  to 
sodium. Sodium  ions enter the cell through voltage‐gated sodium channels. This change 
in  cell potential  from negative  to positive  (depolarization)  and back  (re‐polarization)  is 
called the "action potential", which causes a muscle contraction. Other ions and charged 
molecules such as potassium, calcium, chloride, and charged proteins are also involved in 
the action potential. The action potential can be recorded by electrodes at the surface of 
the skin. A recording of the heart's electrical activity is called an electrocardiogram (EKG) 
whereas recording of other muscles is called an electromyogram (EMG).  
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Spontaneous depolarization occurs in a cluster of cardiac‐muscle cells in the upper wall of 
the  right  atrium.  This  group  of  cells  is  called  the  pacemaker  or  sinoatrial  (SA)  node. 
Depolarization of  the pacemaker generates a  current  that depolarizes all other  cardiac 
muscle cells. The wave of depolarization  travels  rapidly  from  the  right  to  left atrium so 
both atria contract simultaneously. 
 
The atria and the ventricles are isolated from each other electrically by connective tissue. 
Hence depolarization of the atria does not directly affect the ventricles.  Another group of 
cells  in the right atria, called the atrioventricular (AV) node, conducts the depolarization 
of the atria down a special bundle of conducting fibres (Bundle of His) to the ventricles. In 
the muscle wall of the ventricles, muscle fibres called Purkinje fibres bring depolarization 
to all parts of  the ventricles  simultaneously. This process  causes a  small  time delay,  so 
there  is a  short pause after  the atria  contract before  the ventricles  contract. Since  the 
cells of the heart muscle are interconnected, this wave of depolarization, contraction, and 
re‐polarization spreads across all of the connected muscle of the heart. 
 
When  a  portion  of  the  heart  is  polarized  and  the  adjacent  portion  is  depolarized,  an 
electrical current  is created that moves through the body. This current  is greatest when 
one half of  the connected portion of  the heart  is polarized and  the adjacent half  is not 
polarized.  The  current  decreases  when  the  ratio  of  polarized  tissue  to  non‐polarized 
tissue is less than one to one.  The changes in these currents can be measured, amplified, 
and plotted over  time.  The  EKG  represents  the  summation of  all  the  action potentials 
from the heart, as detected on the surface of the body.   
 
The impulse originating at the SA node causes the atria to contract, forcing blood into the 
ventricles.  Shortly  after  this  contraction,  the  ventricles  contract  due  to  the  signal 
conducted to them from the atria. The blood leaves the ventricles through the aorta and 
pulmonary artery. The polarity of the cardiac muscle cells returns to normal and the heart 
cycle starts again.  
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A typical electrocardiogram (EKG) is shown below.  These repetitive waveforms arise from 
a flat baseline called the  isoelectric  line. Any deflection from the  isoelectric  line denotes 
electrical activity. 
 
 

The Electrocardiogram 
 

 
 
The 5 major deflections on a normal EKG cycle are designated by P, Q, R, S, and T.  A cycle 
begins with the P wave, followed by the QRS wave complex, and ends with the T wave. 
The  P  wave  represents  depolarization  (and  contraction)  of  the  atria.    The  QRS wave 
complex consists of three waves ‐ Q (small negative wave), R (large positive wave) and S 
(negative wave). The QRS wave complex denotes depolarization and contraction of  the 
ventricles. Atrial re‐polarization occurs during depolarization of the ventricles.  Therefore 
the waveform associated with atrial  re‐polarization  is undetectable  in an EKG. The  last 
wave indicating ventricular re‐polarization is the positive T wave. 
 
The sequence from P wave to T wave represents one heart cycle.  The number of cycles in 
a minute is the heart rate which is typically 70‐80 beats per minute at rest. Some typical 
times for the EKG are: 
 

P‐R interval    0.12 to 0.20 seconds 
QRS interval    less than 0.10 seconds 
Q‐T interval    less than 0.38 seconds 
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EMG (Electromyogram) 
 
Muscle  contraction  is  controlled  by motor  units  that  have  both  neural  and muscular 
components.  The neural component, called a motor neuron, has a cell body in the spinal 
cord and an axon that extends to a particular muscle. At the muscle the axon branches, 
hundreds  or  thousands  of  times,  to  connect  with  numerous  muscle  fibres  at 
neuromuscular  junctions. When  the motor  unit  is  activated  (recruited),  all  the muscle 
fibres at which  it has a neuromuscular  junction are excited  in synchrony.   This produces 
an action potential, and a brief contractile response. 
 

 
 

The excitation of the muscle fibres in a motor unit can be measured on the surface of the 
skin using electrodes attached  to an Electromyograph  (EMG).   Each excitation causes a 
brief potential that appears as an electrical spike, called a motor unit spike.  The pattern 
of responses from the muscle is called an electromyogram, in which the motor unit spikes 
are plotted against time. 
 
Note  that  the  EMG,  like  the  EKG measures  the  electrical  activity,  not  the mechanical, 
activity  of  the muscle.   Associations  between  electrical  and mechanical  events  can  be 
studied by observing muscle movement while using  the EMG  sensor. This can be done 
visually  by  observing  a  knee  jerk  response  after  a  patellar  tap,  or  by  using  Hand 
Dynamometer together with the EMG Sensor. 
 
Motor  units  differ  with  respect  to  the  size  of  the  motor  neuron  cell  body  and  the 
diameter of the axon.   Smaller motor units control a smaller number of  fibres, whereas 
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larger motor units  in  the same muscle control a  larger number of  fibres.   The EMG can 
distinguish between motor units, because the smaller units produce an electrical signal of 
lower amplitude than the  larger units.   Thus, a  large  frequency of  low amplitude motor 
unit spikes, indicates that many smaller motor units are operating. 
 
The use of voluntary muscles  is  initiated by excitation of neurons  in the motor cortex of 
the  cerebrum.    Upper  motor  neurons  in  the  cerebrum  have  descending  fibres  that 
terminate  in  the  spinal  cord, where  they  can  excite  the  cell  body  of  the  lower motor 
neuron.  If a strong contraction of a muscle is required, a greater amount of excitation is 
produced in the descending fibres, which results in the stimulation of a greater number of 
lower motor units.  The smaller motor units are activated first, and the number of these 
recruited,  increases with the desired strength of the muscular contraction.   For stronger 
contractions,  the  larger  motor  units  are  recruited,  their  number  increasing  as  effort 
increases.   For the greatest degree of effort, the very  largest motor units are recruited.  
Thus, an electromyogram of a muscle that is put under increasing strain will show a series 
of  low amplitude motor unit spikes  to begin with, and  then  the  frequency of  these will 
increase before spikes of moderately high amplitude are recorded.   When the muscle  is 
contracted  with  the  greatest  effort  there  will  be  a  high  frequency  of  both  low  and 
moderate motor spikes with an increasing frequency of the highest amplitude spikes. 
 
When  the muscular  effort  is  decreased  gradually,  the  reverse  situation  occurs.    The 
highest amplitude spikes disappear first, followed by the moderately high spikes, until at 
the lowest level of effort just a few of the lowest amplitude spikes remain. 
 
 
 

Components for use with the EKG/EMG Sensor 
 

Q‐S207 EKG/EMG sensor 
Power supply for Q‐S207  
A263 Tab Electrodes (pkg. of 100) 
C610 LabQuest Mini data acquisition interface (not included) 
C901 Logger Pro Data Acquisition Software (not included) 
C404 Customized Setup Files (not included) 
Manual 
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Quick Startup Steps 
 

1. Load Logger Pro software onto the computer (see pg. 12) 
2. Load C404 custom Qubit experimental files (see pg. 13) 
3. Connect the power supply to the Q‐S207 EKG/EMG 
4. Connect the output data cable to (analog) channel 1 on the LabQuest Mini  
5. Connect the USB cable between the LabQuest Mini and the computer 

 

EKG Setup 
 
1. Place the switch on the Q‐S207 in the EKG position (to the left) 
2. Connecting the Q‐S207 to the Subject:  

Press the sticky tab electrodes onto the skin as shown in the photo below. Scrub the areas 
of skin where the patches will be attached with a paper towel to remove dead skin and 
oil.  Rub the skin with a small amount of isopropyl (rubbing) alcohol to  improve contact. 
Place each electrode so the tab points down. 

 Press the 1st electrode on the inside of the right wrist. 

 Press the 2nd electrode on the inside of the right elbow. 

 Press the 3rd electrode on the inside of the left elbow. 

 Connect the black (or "reference") alligator clip to the right wrist electrode.  This is the 
reference point for the isoelectric line (baseline). 

 Connect the green (negative) alligator clip to the right elbow electrode. 

 Connect the red (positive) alligator clip to the left elbow electrode. 
Note the wires may be taped to the arms to avoid pulling off the electrodes. 
Once opened, the electrodes should be stored in a refrigerated, clean, dry and 
airtight container. 



 

8 
 

 
 
 

 
 
 

3. Open the Q‐S207 EKG Setup file to start the Logger Pro software. Note for 
convenience, a shortcut to this file can be placed on the desktop. 

4. A Sensor confirmation screen will open in Logger Pro as shown below. "Connect" 
the Q‐S207 EKG/EMG sensor on channel 1 of the LabQuest Mini.  

 

 
 

Logger Pro will now open with the following screen setup for EKG. The page has a 
data table, signal meters and graphs. The user can easily customize the screen: new 
tables, meters or graphs can be added using the menu command Insert. Custom 
equations can be inserted with the menu command Data>New Calculated Column. 
Digital filtering can be accessed as a function in the new calculated equation. 
Histogram and FFT analysis is available for EKG signals via Insert>Additional Graph. 
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5. Let the subject relax. The output of the EKG/EMG sensor is now ready for an EKG 
experiment.  See Appendix 1 for suggested EKG experiments. 
 

 
It is important that the subject remains motionless during an experiment, since muscle 

movement will affect the signal. 
 

Note: The Q‐S207 outputs a 0‐5 V voltage signal that does not require calibration by 
the user. 

 
 

EMG Setup 
 

1. Place the switch on the Q‐S207 in the EMG position (to the right) 
2. Connecting the Q‐S207 to the Subject:  

 
Press the sticky tab electrodes onto the skin as shown in the photo below. Scrub the areas 
of skin where the patches will be attached with a paper towel to remove dead skin and 
oil.  Rub the skin with a small amount of isopropyl (rubbing) alcohol to  improve contact. 
Place each electrode so the tab points down. 
Two of  the electrodes  (positive‐red; green‐negative) are placed 5  to 6 cm apart on  the 
skin overlying the muscle to be studied. The 3rd electrode (ground‐black) is placed on the 
skin  a  short  distance  from  the  other  two,  outside  the  region where  the muscle under 
study is active (e.g. on the ankle for calf muscle activity). 
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Note the wires may be taped to the arms to avoid pulling off the electrodes. 
Once opened, the electrodes should be stored in a refrigerated, clean, dry and 
airtight container. 

 

 
 

 

 
 
 

1. Open the Q‐S207 EMG Setup file to start the Logger Pro software. Note for 
convenience, a shortcut to this file can be placed on the desktop. 

2. A Sensor confirmation screen will open in Logger Pro as shown below. "Connect" 
the Q‐S207 EKG/EMG sensor on channel 1 of the LabQuest Mini.  
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Logger Pro will now open with the following screen setup for EKG. The page has a 
data table, signal meters and a graph. The user can easily customize the screen: new 
tables, meters or graphs can be added using the menu command Insert. Custom 
equations can be inserted with the menu command Data>New Calculated Column. 
Digital filtering can be accessed as a function in the new calculated equation. 
Histogram and FFT analysis is available for EMG signals via Insert>Additional Graph. 
 

 
 

 
 

3. Let the subject relax. The output of the EKG/EMG sensor is now ready for an EMG 
experiment.  See Appendix 1 for suggested EMG experiments. 
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It is important that the subject remains motionless during an experiment, since muscle 

movement will affect the signal. 
 

Note: The Q‐S207 outputs a 0‐5 V voltage signal that does not require calibration by 
the user. 

 
 
 
 

Data Acquisition Using the LabQuest Mini Interface 
 
 
LabQuest Mini Interface 
 
The LabQuest Mini interface has 3 analog and 2 digital channels. The interface is 
connected to the computer (PC or Macintosh) by a USB cable. The interface converts the 
analog voltages (12 bit A to D) to digital signals which are transmitted to the computer via 
USB and processed by the Logger Pro software. The green LED indicates that the 
LabQuest Mini is recognized by the drivers and ready to collect data. 
 

 

 
 

 
Installing and Running Logger Pro 3 
 
PC Users: 
 

(1) To  start,  a  complete  copy  of  Logger  Pro  3 must  be  installed  on  the  computer.    Before 
starting  the  installation, make  sure  all USB  cables  are  disconnected  from  the  computer.  
Failure to do so may cause an error in the installation of the drivers. 

(2) Run the installation and do not change the default destination directory.  Logger Pro 3 will 
be installed in C:/Program Files/Vernier Software/Logger Pro 3. 
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(3) The setup process will automatically load the USB drivers for connecting the LabQuest Mini 
or other interfaces to the computer. 

(4) If QuickTime  6  (or  greater)  is  not  installed  on  the  computer,  install  it when  prompted.  
QuickTime will allow use of the picture and movie features of Logger Pro 3. 

(5) You will be prompted to connect the LabQuest Mini or other interfaces to the computer via 
the USB connection.   

(6) Click ‘Finish’ to complete the installation process. 

(7) Proceed to the C404  installation  (below) before opening the Logger Pro with the “Q‐S207 
EKG Setup” or “Q‐S207 EMG Setup” file. 

(8) Double click the “Q‐S207 EKG Setup” or “Q‐S207 EMG Setup” file (create a shortcut on the 
desktop  once moved  from  the  C404  disk  for  easy  access)  to  start  Logger  Pro  and  data 
collection.  If  Logger  Pro  detects  the  LabQuest Mini  interface,  the  Logger  Pro  screen will 
appear with a star (icon for LabQuest Mini) in the top left corner. 
 

  
 

(9) If Logger Pro cannot detect the LabQuest Mini Interface, a message will appear “no device 
connected”.   The LED on the Mini should be green.   A red LED  indicates that power  is on 
(supplied by the computer through the USB) but there  is no communication between the 
interfaces  and  the  computer.    In  this  case,  exit  the  “Q‐S207  EKG/EMG  Setup”  file  and 
unplug the USB cable from the computer.  Reconnect the USB cable. Allow the computer to 
recognize the Mini (bell tone) and then re‐open the “Q‐S207 EKG/EMG Setup” file. 

 
 

Macintosh Users: 
(1) To start, a complete copy of Logger Pro 3 must be installed on the computer (You 

must be using at least OS 9.2).  Run the “Complete Installation” and ensure all USB 
cables are disconnected. The  following  instructions are the same as those for PC 
users. 

 

 
 
C404 Custom Setup Files: 
 
Qubit Systems’ C404 Custom Setup Files CD contains all of Qubit Experiment files 
(designed by Qubit Systems) including “Q‐S207 EKG Setup” and “Q‐S207 EMG Setup”. The 
Experiment files contain the setup (i.e. graphs, table, calculations etc) for the various 
experiments, as well as the calibration constants for the Qubit sensors.  The C404 disk 
also contains manuals for the different Qubit sensors and packages. These files can be 
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copied to user specified location on the computer and the experimental file of interest for 
this sensor – “Q‐S207 EKG Setup”  and “Q‐S207 EMG Setup” should be placed in an 
accessible location or have a shortcut created on the desktop to the file.  
 
 
Graph Ranges, Run Time and Data Collection Rate 
 
To modify the range of the x and y‐axes, click on the maximum and/or minimum values 
and type in the new values. 
 
If you wish  to alter  the maximum  time allotted  to your experiment or  the  rate of data 
sampling, select “Experiment”, then “Data Collection” or click on the clock icon in the top 
menu. 
 
 

 
 
 
Type  in  the  run  time of your experiment  in  the box  labelled “Duration”. Note  that  the 
maximum value you select for the Time‐axis limits the time over which you can collect 
data  for  a  particular  run.    If  your  experiment  exceeds  the  allotted  time,  select 
“Experiment”, then “Store Latest Run”.  You may then restart data collection.  Data from 
the first part of your experiment will remain on the screen as a faint trace and new data 
will be plotted  in a bolded shade of the same colour.   You can collect numerous runs  in 
this way.  Each run will be collected to a separate data table.  When you save your data, 
all of the runs will be saved under the same file name. 
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You may also alter the "Sampling Rate" at which you collect data.   The default rates for 
EKG and EMG are 500 and 1000 samples/s, respectively.   
 
Data Collection and File Saving 
 
To  start  data  collection,  click  on  the  “Collect”  green  icon  above  the  graphs.    This will 
change to a “Stop” red icon.  Click on the “Stop” icon to stop data collection. 
 

 
 
 
Data Analysis with Logger Pro 3 
 
(1) Position the cursor at the beginning of the data set that you wish to analyze, then 

click and hold with the mouse. 
 
(2) Drag  the cursor across  the data set and unclick.   A greyed box will appear on  the 

screen to show the data range to be analyzed. 
 
(3) Select  “Analyze”,  and  then  choose  from  a wide  variety  of  analysis  options.    For 

example, use: 
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 “Examine” to scroll through the data points at specific time intervals. 

 “Integral” to integrate the selected data. 

 “Statistics” to automatically perform a variety of statistical analyses. 
 

You can also fit curves and tangents to the selected data by choosing the appropriate 
menu option. Note the analysis functions can also be accessed from icons in the menu. 

 
 
 
 

EKG/EMG Specifications 

 power supply:      9V DC, 560mA 
 units:         Volts 
 resolution:       0.0012 Volts 
 accuracy:       1% Full Scale, or better 
 offset:         N/A  
 gain:         1076 
 Cut‐off Frequency fc:    Low Pass = 1.6kHz, fc High Pass = 0.2Hz 
 size (h/w/l) cm:     2.8/6.2/9.2 
 weight (g):       210 
 materials:       plastic (black) 
 subject isolation:    1500 V rms 
 warranty:       1 year 
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Appendix 1: Suggested EKG Experiments with the Q‐S207 Sensor 

 
(1) Resting EKG 

 
Record  the  EKG  of  a  subject  at  rest.    The  person  should  remain  relaxed  and  breathe 
normally.  The  following  screen  shot  shows  a  resting  EKG  recorded  in  Logger  Pro.  The 
heart rate is calculated every 5 sec using the large "R" peaks. 
 

 
 
Using the displayed graph in Logger Pro, record the following information: 
 
 

INTERVAL ANALYSIS    HEART RATE ANALYSIS 

Interval  Time (milliseconds)    Item  Rate (per minute) 

P‐Q      Minimum   

QRS      Maximum   

Q‐T      Average   

 
In a teaching lab these data may be distributed to the class for further statistical analysis. 
 



 

18 
 

(2) EKG After Mild Exercise  
 
Record an EKG of a person who is initially at rest.  Disconnect the sensor wires from the 
electrodes, but leave the patches on the subject.  Have the person exercise for 3 minutes 
by  jogging "on the spot". Reattach the sensor wires to the electrodes when the subject 
has finished exercising and record a new EKG.  Compare the resting EKG to the EKG after 
mild exercise.  
 

(3) EKG and Different Body Positions  
 
Record the resting EKG in a sitting position.  Then have the person stand or lie down and 
record a second EKG.   Compare  the new EKG with  the  resting EKG  in a sitting position.  
Note any changes in heart rate, interval times, height of R wave, etc. 
 

(4) EKG and Mild Stimulants 
 
Have  the  subject drink a  couple of  cups of  caffeinated  coffee or  cola.   Record an EKG.  
Compare  the  results with  those  at  rest  and  following mild  exercise.   Note:  This might 
show less effect on people who are accustomed to large amounts of caffeine. 
 
 

(5) EKG and Electrode Position: Axis of the Heart 
 
Note: This is a more advance exercise.  
 
Different arrangements of electrode patches will change  the shape and  intensity of  the 
measured  signal.  Each  arrangement  is  called  a  "lead."  Each  lead  reveals  unique 
information based on the lead's orientation relative to the axis of the heart.  Remember 
to scrub the areas of the skin where the electrode patches are placed with a paper towel 
to remove skin oil and moisture. 
 
Lead I: 
 

 Put an electrode on the right upper arm. Connect the green (negative) alligator clip to 
this electrode. 
 

 Put an electrode on the left upper arm. Connect the red (positive) alligator clip to this 
electrode. 
 

 Put an electrode on the inside surface behind the right anklebone. Connect the black 
(or  "reference")  alligator  clip  to  this  electrode.  This  is  the  reference  point  for  the 
isoelectric line. 
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 An  imaginary  line  between  the  red  and  green  electrodes  shows  that  this  lead  is 
measuring  polarity  changes  across  the  chest,  above  the  heart,  and  parallel  to  the 
shoulders. 

 
Lead II: 
 

 Put an electrode on the right upper arm. Connect the green (negative) alligator clip to 
this electrode. 
 

 Put  an  electrode  on  the  inner  surface  of  the  left  thigh.  Connect  the  red  (positive) 
alligator clip to this electrode. Note:  Instead of  the  left thigh, you can use the  inner 
surface of the left ankle just behind the left anklebone. 
 

 Put  an  electrode  on  the  inside  surface  of  the  area  behind  the  right  anklebone. 
Connect the black (reference) alligator clip to this electrode. 
 

 An  imaginary  line between the red and green electrodes yields an oblique  line  from 
the right shoulder towards the left leg.  Lead II generally gives the greatest variation 
of impulse and is the EKG usually shown in movies, textbooks, etc. 

 
 
Lead III: 

 

 The lead III arrangement has the green (negative) electrode connected to the left arm 
and  the  red  (positive)  electrode  connected  to  the  left  inner  thigh  with  the  black 
(reference)  electrode  connected  to  the  inside  of  the  right  ankle  as  before.   Note: 
Instead of the left thigh, you can use the inner surface of the left ankle just behind the 
left anklebone. 
 

 This arrangement of  the red and green electrodes yields an  imaginary  line  from  the 
left shoulder to the left leg. 
 

 If the three imaginary lines were connected, they would make a triangle. This triangle 
is called the Einthoven triangle. The measured  intensity of voltage on  its three sides 
can be used to study heart functions and anatomy.   You can make an approximation 
of the axis of your heart: that is, the orientation of the centreline of the mass of your 
heart. 
 

 Record a Lead I EKG, a Lead II EKG and a Lead III EKG. Compare the results. Determine 
which lead yields the maximum R‐wave amplitude. 
 

 If the maximum R wave is with Lead I, then the axis of your heart is approximately at 
O degrees as measured from the horizontal and your left. 
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 If the maximum R wave is with Lead II, then the axis of the heart is approximately 60 
degrees down from the horizontal and to the left. 
 

 If  the maximum R wave  is with Lead  III,  then  the axis  is approximately 120 degrees 
from the horizontal and your left. 
 

 You can make a further refinement in your estimate by noting the relative proportion 
of R wave strength between the two leads with the largest R wave. 
 

 If the Lead II and the Lead III R waves are about equal, then the axis is about halfway 
between the 60‐degree angle and the 120‐degree angle. You could therefore estimate 
the axis of the heart to be nearly vertical. 
 
Note:  The heart's  axis  varies with  general body  shape. Very  slender  and  elongated 
people  tend  to have a more vertical heart. Short and  stocky people  tend  to have a 
more horizontal axis. 
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APPENDIX 2: SUGGESTED EMG EXPERIMENTS WITH THE Q‐S207 SENSOR  
 

The following screen shot shows an EMG from a forearm muscle recorded by the Q‐S207 
with Logger Pro. Increasing tension was applied in the first muscle contraction. 

 

 
 

The EMG Sensor may be used for various studies of the electrical activity of muscles. 
 
(1) Involvement of  specific muscles  in  specific actions:   Attach  the electrodes  to  the 

skin over the gastrocnemius (calf) muscle.  Determine to what extent this muscle is 
involved in: 

 
(i) Flexion of the  foot upward and downward when the subject  is sitting without 

weight being placed on the leg. 
 
(ii) Raising  the  foot onto  the  toes, and  then  rocking  the  foot back onto  the heels 

when the subject is standing. 
 
(iii) Control of balance.   This  is best done while the subject  is standing on one  leg, 

with the electrodes attached to the gastrocnemius muscle of that leg.  The tips 
of the index fingers may be rested lightly on the bench‐top to assist balance. It 
is interesting to observe changes in the muscle activity when the eyes are open 
and closed.  Is the muscle “quieter” when the eyes are open?  To what extent is 
the excitation of the muscle under voluntary control?  
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(2) Investigations of  reflex  responses  to a  tendon  tap:   Attach  the electrodes  to  the 
skin over the gastrocnemius muscle while the subject is sitting with feet off the floor 
and the  leg relaxed.   Tap the patellar tendon to elicit a knee  jerk and observe the 
EMG signal.  Tap the Achilles tendon and observe the response.  Which, if either, of 
these treatments elicits a response?  Is the magnitude of the EMG signal related to 
strength of the tap on the tendon? 

 
(3) Comparison of  fatigue between  similar muscles on  the  right and  left  side of  the 

body: 
 

 For a given force exerted repeatedly, how does motor unit recruitment differ 
between the left and right sides? 

 

 How does motor unit recruitment change as the force is increased?  Does this 
differ between left and right sides? 

 

 How does motor unit recruitment change as the force is decreased?  Does this 
differ between left and right sides? 

 

 How does all the above compare athletes compared to non athletes? 
 
 

 Use of the EMG Sensor with Qubit System’s Hand Dynamometer. 
 
  The  experiments  described  in  (3)  above  may  be  carried  out  by  investigating  the 

muscles of the forearm while applying force to a Hand Dynamometer with the left and 
right  hands.    If  increasing  forces  are  applied  to  the  Hand  Dynamometer  while 
monitoring the increasing EMG signal it should be possible to observe the recruitment  
of  more  and  larger  motor  units  as  load  is  increased.  Histogram  analysis  (menu 
command Insert>Additional Graph) can be used to sort the different sized pulses (i.e. 
action potentials) in the EMG signal. The motor units are de‐recruited gradually at the 
end  of  the  experiment  if  the  load  exerted  on  the  hand  dynamometer  is  slowly 
lowered. 

 
(4) The EMG may be used as a guide to muscle relaxation via biofeedback. 
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Qubit Systems Warranty Information 
 

QUBIT warrants all  its  instruments to be  free  from defects  in materials or workmanship 
for a period of one year  from the date of  invoice/shipment  from QUBIT.    If at any time 
within this warranty period the instrument does not function as warranted, return it and 
QUBIT will repair or replace it at no charge. The customer is responsible for shipping and 
insurance charges (for the full product value) to QUBIT.  QUBIT is responsible for shipping 
and  insurance on return of the  instrument to the customer.       No warranty will apply to 
any  instrument that has been (i) modified, altered, or repaired by persons unauthorized 
by  QUBIT;  (ii)  subjected  to misuse,  negligence,  or  accident;  (iii)  connected,  installed, 
adjusted, or used otherwise than in accordance with the instructions supplied by QUBIT.   
The warranty  is return‐to‐base only, and does not  include on‐site repair charges such as 
labour, travel, or other expenses associated with the repair or installation of replacement 
parts at the customer’s site.   QUBIT repairs or replaces the faulty  instruments as quickly 
as possible; maximum time  is one month. QUBIT will keep spare parts or their adequate 
substitutes  for a period of at  least  five years. Returned  instruments must be packaged 
sufficiently  so  as  not  to  assume  any  transit  damage.  If  damage  is  caused  due  to 
insufficient packaging,  the  instrument will be  treated  as  an out‐of‐warranty  repair  and 
charged as such.  
QUBIT also offers out‐of‐warranty repairs. These are usually returned to the customer on 
a cash‐on‐delivery basis.   
Wear & Tear Items are excluded from this warranty. The term Wear & Tear denotes the 
damage that naturally and inevitably occurs as a result of normal use or aging even when 
an item is used competently and with care and proper maintenance. 
 

Return Procedure 
 
Before returning any instrument to QUBIT:   
Consult the operating manual or contact Qubit to ensure that the instrument(s) is in fact 
faulty and has not just been set up improperly.  
Contact QUBIT before sending anything back.  We will issue an RMA number and provide 
shipping  instructions.     QUBIT will  refuse any goods  that are  returned without an RMA 
number, or which are sent in a manner outside of QUBIT’S  stipulations. 
If you have encountered a program failure, we need a printed copy of any faults you have 
seen,  including how to reproduce them.   Include these  in the return package along with 
your mailing address.  
Include a copy of the Invoice on which the product was shipped to you.  
All returns must be shipped prepaid.  Unpaid packages will not be accepted.  
In case of questions contact QUBIT by  
E‐mail: info@qubitsystems.com, 
 by phone: (01)‐613 384 1977,  
or by fax: (01)‐613 384‐ 9118. 

 


